Introduction .................................................................................................................. 1
The WebCenter Task Flow Customization Process .............................................. 3
Preparing a Customizable WebCenter Application .......................................... 4
  Create the Customization Classes ................................................................. 4
  Make the Customization Classes Available to JDeveloper .................... 7
Enable Seeded Customizations for View Projects in WebCenter Applications ........................................................................................................ 8
Configure the Design Time Customization Layers for JDeveloper .......... 9
Configure Your Application’s adf-config.xml File .................................. 10
Make WebCenter Spaces Task Flow Libraries Available to Your Application ...................................................................................................... 12
  Restart JDeveloper in the Customization Developer Role and Verify the Configuration ........................................................................ 15
Customizing WebCenter Task Flows ................................................................. 17
  Use Case 1: (WebCenter Spaces) Adding a Link to the WebCenter Spaces Global Toolbar Task Flow ................................................................. 18
  Use Case 2: (WebCenter Spaces) Modify the Label in the WebCenter Spaces Global Toolbar Task Flow ................................................................. 20
  Use Case 3: (WebCenter Spaces) Removing Primary Tabs from the Local Toolbar Task Flow ........................................................................ 23
  Use Case 4: Customizing the Discussion Forums Task Flow .... 25
Modifying Customizations to a Deployed WebCenter Application .... 28
Applying Seeded Customizations to Deployed WebCenter Applications 29
Applying Seeded Customizations for Use Case 2 “(WebCenter Spaces) Modify the Label in the WebCenter Spaces Global Toolbar task Flow”.... 32
Removing Seeded Customizations from a Deployed WebCenter Application .................................................................................................................. 32
Catalog of WebCenter Task Flows .................................................................. 33
Conclusion ........................................................................................................ 42
Introduction

By taking advantage of the Oracle Metadata Services (MDS) framework, Oracle WebCenter enables you to create rich, customizable applications and tailor them to the needs of your organization. You can customize the task flows associated with Oracle WebCenter’s Social Computing Services and WebCenter Spaces. You customize task flows in JDeveloper and then apply the customizations to a running WebCenter application.

Oracle WebCenter supports several levels of customizations:

- Seeded customization, which application developers perform at design time. Seeded customizations stay with the application for the duration of the application’s deployment.

- User customization, which allows an end user to change the content of the application at runtime to suit individual preferences (for example, the specific columns that should be visible in a table), and have those changes "remembered" the next time the user opens the application.

- Design time at runtime, which enables different roles to perform various customizations during the runtime of the application. Oracle WebCenter supports this capability by integrating with Oracle Composer.
WebCenter task flow customization is an example of a *seeded customization*. As an application developer, you customize the task flows for your organization’s needs in JDeveloper, and apply them to the deployed application. These seeded customizations then remain in effect for the duration of its deployment.

Oracle WebCenter makes it easy for you to perform and apply task flow customizations. Since the Oracle WebCenter Framework design time experience is provided as an extension to Oracle JDeveloper 11g, you can take advantage of JDeveloper roles that scope the development environment for a particular task. One of these roles is the “Customization Developer” role, which helps you customize the metadata of your application with minimal coding. For more information on customizing a custom WebCenter application’s metadata, refer to Chapter 5, “Extending Runtime Editing Capabilities Using Oracle Composer” in *Oracle Fusion Middleware Developer's Guide for Oracle WebCenter* for more details.

WebCenter’s Social Computing Services and WebCenter Spaces expose their common functionalities using task flows. By using JDeveloper’s Customization Developer role, you can customize WebCenter task flows to extend or alter the out-of-the-box look and feel and functionality of these task flows.

You can learn more about the types of customization in the *Oracle Fusion Middleware Developer’s Guide for Oracle Application Development Framework*. To learn more about Oracle WebCenter and WebCenter Web 2.0 Services, see the *Oracle Fusion Middleware Developer’s Guide for Oracle WebCenter*. Both of these guides are available in the Oracle Fusion Middleware Documentation Library 11g Release 1 (11.1.1) on the Oracle Technology Network (http://download.oracle.com/docs/cd/E12839_01/index.htm).
The WebCenter Task Flow Customization Process

In Oracle WebCenter 11g Release 1, you can perform View-level customization on your WebCenter applications, such as changing the look and feel of the task flow, adding ADF user interface (UI) components on a task flow page, or deleting UI components from a task flow page (fragment.) All JSPX customization is possible; ADF model or controller customizations are not currently supported.

This whitepaper covers the following steps to prepare a customizable WebCenter application and customize WebCenter task flows:

1. Create a WebCenter application
2. Create the customization classes
3. Make the customization classes Available to JDeveloper
4. Enable seeded customizations for the View project in your WebCenter application
5. Configure the design time customization layers for JDeveloper
6. Configure the WebCenter application’s adf-config.xml file for customization
7. (Optional) Making WebCenter Spaces task flow libraries available to a WebCenter application
8. Restart JDeveloper in the Customization Developer Role

The following diagram shows the process for customizing WebCenter task flows.
Note: When you apply task flow seeded customizations to a deployed WebCenter application, the customizations apply to all instances of the task flow across the application, eliminating the need to repeat customizations for a particular task flow on every page that contains the task flow. You can enable task flow customization in a custom WebCenter application or in WebCenter Spaces.

**Preparing a Customizable WebCenter Application**

To customize the task flows in your WebCenter application, first ensure that you have a custom WebCenter application (that is, an application you’ve created using the WebCenter Application template). You can also create a new one for the purposes of following these steps. To do so, in JDeveloper, open the New Gallery, choose Applications, then choose WebCenter Application. For the purposes of this document, name your sample WebCenter application “SampleWebCenterApplication.”

**Create the Customization Classes**

Once you have created a WebCenter application, you must make the customization classes that you want to use in your application. A customization class is the interface that MDS uses to define which customization applies to the base definition metadata. Each customization class defines a customization layer and can contain multiple layer values.

To create customization classes for a custom WebCenter application:
1. In the Application Navigator, select the application’s ViewController project, then choose File > New.

2. In the New Gallery, choose the Java category, and then choose Java Class from the Items list.

3. In the Create Java Class dialog, create a new Java class named “WCSiteCC” that extends the oracle.mds.cust.CustomizationClass and click OK.

Figure 2. Creating a Java Class
4. In the Source code of the WCSiteCC.java file, replace the code with the following:

**Code Listing 1: WCSiteCC.java Code**

```java
package view;
import java.io.IOException;
import java.io.InputStream;
import java.util.Properties;
import oracle.mds.core.MetadataObject;
import oracle.mds.core.RestrictedSession;
import oracle.mds.cust.CacheHint;
import oracle.mds.cust.CustomizationClass;

public class WCSiteCC extends CustomizationClass {
    private static final String DEFAULT_LAYER_NAME = "site";
    private String mLayerName = DEFAULT_LAYER_NAME;

    public WCSiteCC() {
    }

    public WCSiteCC(String layerName) {
        mLayerName = layerName;
    }

    public CacheHint getCacheHint() {
        return CacheHint.ALL_USERS;
    }

    public String getName() {
        return mLayerName;
    }

    public String[] getValue(RestrictedSession sess,
                              MetadataObject mo) {
        return new String[] {"webcenter"};
    }
}
```

**Note:** The example code uses a customization layer “site” with the value “webcenter”. For more details on CustomizationClass, refer to Chapter 5, “Extending Runtime Editing Capabilities Using Oracle Composer” in the Oracle Fusion Middleware Developer's Guide for Oracle WebCenter.

5. Rebuild the ViewController project by right-clicking ViewController in the Application Navigator, and choosing Rebuild ViewController.jpr.
Make the Customization Classes Available to JDeveloper

After you create the customization classes, you must make them available to JDeveloper so that you can use them when implementing customizations. When working in JDeveloper Customization Developer role, your customization classes must be available in JDeveloper IDE’s classpath.

To include the customization classes in your application:

1. In the Application Navigator, right-click the ViewController project for your application and choose Project Properties.
2. In the Project Properties dialog, click Deployment, then click New.
3. In the Create Deployment Profile dialog, name the new JAR file myCC.jar, then click OK.

4. On the JAR Options page, edit the JAR profile, enter the following location for the JAR file:

   JDEV_HOME/jdev/lib/patches/myCC.jar

Note: JDEV_HOME is the name of the directory where JDeveloper was installed.
5. Select Filters on the left and add the WCSiteCC class to the JAR file.

![Figure 4. Adding the WCSiteCC Class to the Deployment Profile](image)

6. Click OK and then click OK again.
7. Save your files.
8. In the Application Navigator, right-click the ViewController project and choose Deploy > myCCjar > To Jar file to deploy the JAR.

Enable Seeded Customizations for View Projects in WebCenter Applications

Once you make the customization classes available to your WebCenter application, you must enable the seeded customizations for the application’s View project.

To enable seeded customizations in your application:

1. In the Application Navigator, right-click the ViewController project, and choose Project Properties.
2. In the Project Properties dialog, select ADF View, then select the Enable Seeded Customizations checkbox.
Figure 5. Enabling Seeded Customizations

3. Click OK and save your files.

Configure the Design Time Customization Layers for JDeveloper

To enable customization of WebCenter task flows at design time, you must configure the CC layer values that you want to use in the JDeveloper Customization Developer role. In your file system directory, in JDEV_HOME/jdev, open the CustomizationLayerValues.xml and configure the CC layer values.

In the following example, the “site” Layer is configured with the value “webcenter” for the JDeveloper Customization Developer role.

Code Listing 2: Customization Layer

```xml
<cust-layers xmlns="http://xmlns.oracle.com/mds/dt">
  <cust-layer name="site" id-prefix="s">
    <cust-layer-value value="webcenter" display-name="WebCenter"/>
  </cust-layer>
</cust-layers>
```
Configure Your Application’s adf-config.xml File

The application's adf-config.xml file must have an appropriate cust-config element in the mds-config section. The cust-config element allows clients to define an ordered and named list of customization classes. You can use the overview editor for the adf-config.xml file to add customization classes.

To configure the adf-config.xml file:
1. In the Application Resources panel, under Descriptors > ADF META-INF, open the adf-config.xml. Before you make any changes to the code, back up the adf-config.xml file.
2. In the Overview editor, select MDS Configuration.
3. Add the WCSiteCC class to the file to generate MDS custom configuration.
4. Save all your files.

The source code of the adf-config.xml file should now contain a reference to the new customization class, view.WCSiteCC.

Code Listing 3: Customization Class Order in the adf-config.xml File

```xml
<adf-config xmlns="http://xmlns.oracle.com/adf/config">
  <adf-mds-config xmlns="http://xmlns.oracle.com/adf/mds/config">
    <mds-config xmlns="http://xmlns.oracle.com/mds/config" version="11.1.1.000">
      <cust-config>
        <match path="/"/>
      </cust-config>
    </mds-config>
  </adf-mds-config>
</adf-config>
```
Make WebCenter Spaces Task Flow Libraries Available to Your Application

To allow customization of WebCenter Spaces task flows, you must perform a few configuration steps to set up the JDeveloper workspace to allow customization of WebCenter Spaces task flows. You only need to perform these steps once. If you are not customizing WebCenter Spaces task flows, you can skip to the next section, “Restart JDeveloper in the Customization Developer Role and Verify the Configuration.”

To customize WebCenter Spaces task flows, you need to include the WebCenter Spaces View JAR file in your project. The WebCenter View jar (webcenter-app-view.jar) is packaged and shipped with WebCenter Spaces, and is located here:

FMW_HOME/lib/java/internal/oracle.webcenter.spaces/11.1.1.0.0/webcenter-app-view.jar

**Note:** FMW_HOME is the name of the directory where WebCenter Spaces was installed.

Oracle WebCenter Social Computing Services’ task flows, such as the Discussion Forum and Mail task flows, are part of the WebCenter Extension and are available in the Task Flows folder in the WebCenter Services Catalog, located in the Resource Palette in JDeveloper.

To set up JDeveloper for WebCenter Spaces task flow customization:
1. In the Application Navigator, right-click the ViewController project for your WebCenter application and choose Project Properties.
2. In the Project Properties dialog, select Libraries & Classpath and click “Add JAR /Directory….” button
3. Navigate to the Oracle WebCenter Spaces installation directory and select webcenter-app-view.jar.

4. Click Select.

5. Click OK.
6. Save your files.

7. In the Application Navigator, next to the Projects dropdown list, click the Navigator Display Options icon and select Show Libraries.
8. Save all your files.

Restart JDeveloper in the Customization Developer Role and Verify the Configuration

After you've enabled customization for your application, you can switch to the Customization Developer role and begin customizing your task flows.

To switch to the Customization Developer role:
1. In JDeveloper, choose Tools > Preferences > Roles, select Customization Developer role, and then click OK.

![Preferences window](image)

![Rules tab](image)

2. Figure 10. Selecting the Customization Developer Role

3. JDeveloper prompts you to restart. Choose Yes to restart JDeveloper in the Customization Developer Role.

4. In JDeveloper, in the Customization Developer role, you see a Customization Context window with the Edit with following Customization Context radio button selected and customization layer name selected as “site” and “webcenter” as the layer value. If you see that means that you have successfully configured your SampleWebCenterApplication to enable customization of Oracle WebCenter task flows.
Customizing WebCenter Task Flows

Out of the box, WebCenter Social Computing Services and WebCenter Spaces have well-defined user interfaces and behavior. One of the features that Oracle JDeveloper includes to help you do this is the Customization Developer role.

JDeveloper’s Customization Developer role is a powerful mechanism that allows you to customize the ADF Library without changing the code in the baselibrary JAR. Since both Oracle WebCenter and Oracle ADF are leverage MDS, you can use the Customization Role to extend WebCenter Spaces and WebCenter Services task flows. All WebCenter task flows are packaged in the ADF Library so task flow customization is possible in JDeveloper design time.

The SampleWebCenterApplication is built on WebCenter technology and already contains some WebCenter Service task flow libraries, which you can see in the Application Navigator. You can see all WebCenter Service task flows under the Resource Palette and add them to this sample application. Any task flow ADF libraries that you add display in the Application Navigator.

The following are four use cases that demonstrate WebCenter task flow customization using the JDeveloper Customization Developer role.

- Use Case 1: In WebCenter Spaces, add a link to the WebCenter Spaces Global ToolBar task flow
- Use Case 2: In WebCenter Spaces, modify the label in the WebCenter Spaces Global ToolBar task flow
- Use Case 3: In WebCenter Spaces, remove the primary tabs from the WebCenter Spaces Local ToolBar task flow
• Use Case 4: In a WebCenter application (a custom WebCenter application or WebCenter Spaces), customize the WebCenter Discussion Forums task flow to show an image next to the author's name.

Use Case 1: (WebCenter Spaces) Adding a Link to the WebCenter Spaces Global Toolbar Task Flow

This example shows how to add a link to the WebCenter Spaces toolbar. The following image shows the various links that display: Group Spaces, Favorites, Preferences, and so on. This toolbar is a rendered view of the Global Toolbar task flow.

![Figure 12. Global Toolbar Task Flow in WebCenter Spaces](image)

Before you can perform these steps, ensure that you have set up JDeveloper to enable WebCenter Spaces task flow customization, as previously described in this document.

To add a link to the WebCenter Spaces Global Toolbar task flow:

1. Ensure that the WebCenter application is open in JDeveloper and that you are using the Customization Developer role.
2. In the Application Navigator, expand the ViewController project, and navigate to webcenter-app-view.jar (added earlier in the section “Making WebCenter Spaces Task Flow libraries available to Application”).
4. Under globalToolbar, select BoilerPlate.jspx and open it.
5. Look for the `af:commandLink` tag with the id “profileLink”.

**Code Listing 4. af:commandLink in the BoilerPlate.jspx file**

```xml
<af:commandLink text="#{security.userDisplayName}" 
actionListener="#{backing_wc_resourceHandler.resourceActioned}" 
id="profileLink" inlineStyle="white-space:nowrap" 
partialSubmit="true" rendered="#{security.authenticated}" 
......
</af:commandLink>
```

6. In the Design view, insert an `<af:goLink>` component after it. Set a link, such as “http://www.example.com/support/welcome.html” as the destination for the newly inserted goLink component.

These steps created the necessary customization for BoilerPlate.jspx under Application_Directory/ViewController/libraryCustomizations/oracle/WebCenter/WebCenterapp/view/task_flows/globalToolbar.
The resulting toolbar looks like this:

![Updated Global Toolbar Task Flow Label in WebCenter Spaces](image)

Figure 14. Updated Global Toolbar Task Flow Label in WebCenter Spaces

Use Case 2: (WebCenter Spaces) Modify the Label in the WebCenter Spaces Global Toolbar Task Flow

This example shows how to change the text label in the Global Toolbar task flow. In WebCenter Spaces, the top left corner of the page displays as follows:

![Global Toolbar Task Flow Label in WebCenter Spaces](image)

Figure 15. Global Toolbar Task Flow Label in WebCenter Spaces

Here, the text in the global toolbar says “WebCenter Spaces.” You can change this text to match your organization’s name or, for example, “WebCenter Groups.”

Before you can perform these steps, ensure that you have set up JDeveloper to enable WebCenter Spaces task flow customization, as described in the section, “Make Oracle WebCenter Spaces Task Flow Libraries Available to Your Application.”

To change the label in the WebCenter Spaces Global Toolbar task flow:

1. Ensure that the WebCenter Spaces application is open in JDeveloper and that you are using the Customization Developer role.
2. In the Application Navigator, expand the ViewController project, and navigate to webcenter-app-view.jar.
4. Under globalToolbar, select BoilerPlate.jspx and open it.
5. In the Structure Window, select the af:outputText component with the ID ”gtbpot1” under the innerStart facet.

**Code Listing 5: af:outputText component**

```xml
<af:outputText value="#{WCAppContext.application.applicationConfig.title}" styleClass="AFBrandingBarTitle" id="gtbpot1"/>
```

6. In the Property Inspector, next to the Value property, click the arrow and click Select Text Resource.
7. In the Select Text Resource dialog, enter a display value of WebCenter Groups and set the ID to WebCenter Groups.
8. Click Save and Select to create an override bundle with a resource key at the application level. If you are performing this action for the first time, a confirmation dialog displays.

![Select Text Resource](image)

**Figure 16. Confirming the Override of the Resource Bundle**

9. Click Yes, then click Save and Select.

Notice that the customization file, GlobalToolbar.jspx.xml, is automatically created under the libraryCustomization folder in the ViewController project with following contents:
This file defines a new Override Resource Bundle in the application's adf-config.xml file.

**Code Listing 7. Updated adf-config.xml File**

```xml
<adf-resourcebundle-config
    xmlns="http://xmlns.oracle.com/adf/resourcebundle/config"
>
  <applicationBundleName>
    resourcebundles/xliffBundles/SampleWebCenterApplicationOverrideBundle
  </applicationBundleName>
  <bundleList>
    <bundleId override="true">
      view.ViewControllerBundle
    </bundleId>
  </bundleList>
</adf-resourcebundle-config>
```

In your file system, in the application's directory, you can also see the application level override resource bundle being created. This resource bundle will contain the new keys that you define in JDeveloper Customization Developer role.

For example:

```
Application_Directory/resourcebundles/xliffBundles/SampleWebCenterApplicationOverrideBundle.xlf
```

The resulting toolbar looks as follows:
Figure 17. Global Toolbar Task Flow Label in WebCenter Spaces

Use Case 3: (WebCenter Spaces) Removing Primary Tabs from the Local Toolbar Task Flow

In WebCenter Spaces, group space navigation is performed through tabs and menus. You can modify the application to show group space navigation only through menu items by customizing the Local Toolbar task flow.

Figure 18. Local Toolbar Task Flow in WebCenter Spaces

Before you perform these steps, ensure that you have set up JDeveloper to enable WebCenter Spaces task flow customization, as previously described in this document.

To remove primary tabs from the WebCenter Spaces Local Toolbar task flow:

1. Ensure that the WebCenter Spaces application is open in JDeveloper and that you are using the Customization Developer role.
2. In the Application Navigator, expand the ViewController project, and navigate to webcenter-app-view.jar.


![Projects](image)

Figure 19. Local Toolbar Task Flow in the Application Navigator

4. Under localToolbar, select LocalBoilerPlate.jspx and open it.
5. In the Structure window, select the wcNavigationPane component with id="primaryTabSet."
6. Delete this comment by pressing the Delete key on your keyboard.

These steps created the necessary customization for LocalBoilerPlate.jspx under Application_Directory/ViewController/libraryCustomizations/oracle/WebCenter/WebCenterapp/view/task flows/localToolbar for BoilerPlate.jspx.
Note: Application_Directory is the name of directory where the JDeveloper application was created.

The resulting toolbar looks as follows:

![Resulting Toolbar](image)

**Figure 20. Resulting Toolbar**

Use Case 4: Customizing the Discussion Forums Task Flow

This example shows how you can customize the Discussion Forums task flow to display a profile image for the user who initiated the discussion. The following is a sample Discussion Forum without the profile image.

![Discussion Forum](image)

**Figure 21. Discussion Forum**

Before you perform these steps, ensure that you have prepared a customizable WebCenter application.

To customize the Discussion Forums task flow:

1. In the Resource Palette, under My Catalogs, expand the WebCenter Services Catalog, and open the Task Flows folder.
2. Right-click Discussion Forums and choose Add to project. If a confirmation dialog displays, click Add Library.
3. In the Application Navigator, expand the ViewController project to view the WebCenter Discussion Services library.
4. In the WebCenter Discussion Services View library, open the ListTopics.jspx file.
5. On your file system, in the SampleWebCenterApplication application directory, create a directory named “images” under ViewController/public_html.
6. While still on your file system, in the ViewController/public_html directory, add a few sample images in GIF format. You can name these image files as valid WebCenter usernames, for example admin.gif, sjones.gif, and so on. These images are the user profile images you’ll add to the task flow.
7. In JDeveloper, click the Refresh icon in the toolbar of the Application Navigator.
8. Save the application.
9. If you are not already using the Customization Developer role, switch to this role (choose Tools > Preferences, select Role, then select Customization Developer Role and restart JDeveloper.
10. In JDeveloper, open the ListTopics.jspx file.
11. In the Structure window, search for the <rtc:presence> tag on the page. This tag renders the username.
12. Right-click the rtc:presence tag, then choose insert After > ADF Faces > Panel Group Layout from the context menu.
13. In the Structure Window, right-click the new Panel Group Layout and choose Insert > Image Component.
14. In the Property Inspector for the new Image component, set the Source property to /images/#{row.postedBy}.gif. This generates the image name (which you added to your application project) named like the user who posted the discussion.
15. Save your files and rebuild the project.

The ListTopics.jspx.xml file that is generated now contains the following code:

**Code Listing 8. Updated ListTopics.jspx.xml File**

```xml
<mds:customization version="11.1.1.54.01"
    xmlns:mds="http://xmlns.oracle.com/mds">
    <mds:insert parent="frmltpgl11" position="last"
        xmlns:af="http://xmlns.oracle.com/adf/faces/rich">
        <af:panelGroupLayout
            xmlns:af="http://xmlns.oracle.com/adf/faces/rich"
            id="s1pgl1">
            <af:image
                xmlns:af="http://xmlns.oracle.com/adf/faces/rich"
                source="/images/#{row.postedBy}.gif" id="s1i1"/>
            </af:panelGroupLayout>
        </mds:insert>
</mds:customization>
```
This example illustrates how you can use EL to customize a task flow in a custom WebCenter application.

Alternatively, you could achieve the same goal in WebCenter Spaces. To do so, populate the Image source attribute value using a managed bean. Then, use the Role APIs to retrieve the image source from a user’s profile in LDAP. The EL in this example uses EL as part of customization, and assumes that the profile image for the user who initiated the discussion is in the format: <user_name>.gif. Note that the images you use must be available in the WebCenter application’s context root, under public_html/images. When you apply the customizations, you must package the images folder in a JAR and make it available in the WebCenter Spaces application’s classpath. To do so, add the images JAR to the default custom shared library custom.webcenter.spaces.war file. You can use Java’s JAR command to update the custom.webcenter.spaces.war file. After adding the JAR, redeploy the shared library.

Figure 24. Discussions Forum Task Flow Rendering the User Profile Image in WebCenter Spaces

For more information on the custom.webcenter.spaces.war file, see the “Extending WebCenter Spaces” whitepaper on the Oracle Technology Network (http://webcenter.oracle.com).

Modifying Customizations to a Deployed WebCenter Application

In the previous sections, we customized WebCenter task flows for four different scenarios. The output of these exercises is the generated MDS customization. The customizations show up as .xml.xml or .jspx.xml files in the View project of the application in the libraryCustomization package. These customization documents are essentially instructions for
MDS to apply delta on top of the base document that is shipped to show the customized behavior at runtime. Once you create the customizations, you must apply them to the deployed WebCenter application.

Applying Seeded Customizations to Deployed WebCenter Applications

To see customizations performed on Oracle WebCenter task flows in JDeveloper at runtime, you must import these customizations to the MDS repository of the deployed WebCenter application. Since this step updates the runtime WebCenter application metadata repository, you should first back up the MDS schema before performing this step. Oracle also advises that you test your customizations in a development or stage environment first.

These steps cover how to apply the seeded customizations to a deployed instance of Oracle WebCenter Spaces. The same steps can be followed to deploy customizations to a custom WebCenter application repository, as well.

To import design time Oracle WebCenter task flow seeded customizations to the MDS repository:

1. While the SampleWebCenterApplication is open in JDeveloper, rebuild the ViewController project by right-clicking ViewController and choosing Rebuild ViewController.jpr.
2. Next, create a JAR profile and package the library customizations under the ViewController project in the JAR archive. In the Application Navigator, these customizations display under ADFLibraryCustomization package. On your file system, the customizations are located in the libraryCustomization folder under ViewController.
   Right-click the Model project and select New.
3. In the New Gallery, select Deployment Profiles, choose JAR File from the Items list, and click OK to generate the JAR profile.
4. Create a name for the JAR file, such as SampleWebCenterApplicationCustomizations.

5. In the Edit JAR Deployment Profile Properties dialog, click Filters on the left, then select all the customization documents in the ADFLibraryCustomization package, then click OK.
Figure 26. Adding the Customization Documents to the JAR File

6. Copy this JAR file, which now contains the customizations, to the machine where the WebCenter application is deployed. Note: Maintain a backup of this file so that you always have a version of the customizations for this application.

7. Extract the JAR to a temporary directory on the machine, for example /tmp/wc-cust.

8. Use the MDS WLST import command to import the task flow customizations to the application’s MDS repository.

The following is an example of the command to import customizations.

Code Listing 9. Command line for Importing Customizations

```
importMetadata(application='webcenter',
server='srg',
fromLocation='~/tmp/wc-cust',
docs='/**')
```
For more information on MDS WLST commands, refer to the *Oracle Fusion Middleware WebLogic Scripting Tool Command Reference* on the Oracle Technology Network.

Applying Seeded Customizations for Use Case 2 "(WebCenter Spaces) Modify the Label in the WebCenter Spaces Global Toolbar task Flow"

For Use Case 2, you must add the configuration of the override resource bundle to the adf-config.xml in the deployed WebCenter Spaces application.

To apply the customizations for Use Case 2:

1. Open the webcenter.ear file and extract the adf-config.xml in META-INF directory.
2. Add the following entry to adf-config.xml for WebCenter Spaces:

   **Code Listing 10: Updating the adf-config.xml file to Apply Customizations for Use Case 2**

   ```xml
   <adf-resourcebundle-config
   xmlns="http://xmlns.oracle.com/adf/resourcebundle/config">
   <applicationBundleName>
   resourcebundles/xliffBundles/SampleWebCenterApplicationOverrideBundle
   </applicationBundleName>
   <bundleList>
   <bundleId override="true">
   view.ViewControllerBundle
   </bundleId>
   </bundleList>
   </adf-resourcebundle-config>
   ```

3. Add the modified adf-config.xml file to the webcenter.ear. You can use Java’s JAR command to update the webcenter.ear.
4. When you’re done, redeploy the webcenter.ear file.

   **Note:** The resource bundle generated should be made available in the WebCenter Spaces application classpath. To do this, add the override resource bundle to the default custom shared library custom.webcenter.war file. You can use Java’s JAR command to update the custom.webcenter.war file. After adding the bundle, redeploy the shared library.

5. Restart the application. You should be able to see the task flow customizations.

Removing Seeded Customizations from a Deployed WebCenter Application
You can remove seeded customizations from a deployed WebCenter application, including WebCenter Spaces. Once you remove the customizations from the application, the task flow behavior or look and feel will revert back to the original deployment.

Use the MDS WLST `deleteMetadata` command to remove the applied customizations. The `deleteMetadata` command needs to exercise with caution as incorrect use of this command may cause the loss of metadata documents.

**Code Listing 11. Command to Delete the Customization Metadata from a Deployed WebCenter Application**

```java
deleteMetadata(application='webcenter',server='srg',docs='/oracle/webcenter/webcenterapp/view/taskflows/globalToolbar/**',excludeBaseDocs='true')
```

For more details on MDS WLST commands, refer to the *Oracle Fusion Middleware WebLogic Scripting Tool Command Reference* on the Oracle Technology Network.

**Catalog of WebCenter Task Flows**

The `webcenter-app-view.jar` contains all the WebCenter task flows listed in the following table. This JAR file is located here:

```
FMW_HOME/lib/java/internal/oracle.webcenter.spaces/11.1.1.0.0/webcenter-app-view.jar
```

<table>
<thead>
<tr>
<th>COMPONENT CATEGORY</th>
<th>UI TASK FLOW NAME</th>
<th>JAR NAME</th>
<th>ORACLE ADF TASK FLOW NAME</th>
<th>DEFINITION FILE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Service</td>
<td>Configuration</td>
<td>forum-view.jar</td>
<td>forum-config-view</td>
<td>wpfas/modules/collaboration/forum-service/view/src/web/oracle/webcenter/collab/forum-view/about/about-view-definition.xml</td>
</tr>
<tr>
<td></td>
<td>Main View</td>
<td>announcement-view.jar</td>
<td>announcement-main-view</td>
<td>wpfas/modules/collaboration/forum-service/view/src/web/oracle/webcenter/collab/forum-view/about/about-view-definition.xml</td>
</tr>
<tr>
<td></td>
<td>Create a link from</td>
<td>announcement-view.jar</td>
<td>link-existing-view-definition</td>
<td>wpfas/modules/collaboration/forum-service/view/src/web/oracle/webcenter/collab/forum-view/about/about-view-definition.xml</td>
</tr>
<tr>
<td>Feature</td>
<td>Module</td>
<td>File Name</td>
<td>Task Flow XML Path</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------</td>
<td>-------------------------------------</td>
<td>--------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Forum Link to Existing</td>
<td>forum-view.jar</td>
<td>forum-link-existing</td>
<td>wpfas/modules/collaboration/forum-service/view/src/web/oracle/webcenter/collab/forum/view/taskflows/link-existing-task-flow.xml</td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Module</td>
<td>Component</td>
<td>Task Flow Definition Path</td>
<td></td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Link Document to Existing</td>
<td>doclib-service-view.jar</td>
<td>doclib-link-to-existing</td>
<td>wpfas/modules/doclib-service/view/src/web/oracle/webcenter/view/jsf/taskflows/relationshipsDialog.xml</td>
<td></td>
</tr>
<tr>
<td>Link Document to New</td>
<td>doclib-service-view.jar</td>
<td>doclib-link-to-new</td>
<td>wpfas/modules/doclib-service/view/src/web/oracle/webcenter/view/jsf/taskflows/relationshipsDialog.xml</td>
<td></td>
</tr>
<tr>
<td>Events Service</td>
<td>event-view.jar</td>
<td>calendar-communityResourceView</td>
<td>wpfas/modules/collaboration/event-service/view/src/web/oracle/webcenter/collab/calendar/views/jsf/search/cal_comm_search_view_task-flow-definition.xml</td>
<td></td>
</tr>
<tr>
<td>Calendar Community Resource View</td>
<td>event-view.jar</td>
<td>calendar-mainView</td>
<td>wpfas/modules/collaboration/event-service/view/src/web/oracle/webcenter/collab/calendar/views/jsf/fragment/calendar_main_view_task-flow-definition.xml</td>
<td></td>
</tr>
<tr>
<td>Calendar Main View</td>
<td>event-view.jar</td>
<td>calendar-personalTimebar</td>
<td>wpfas/modules/collaboration/event-service/view/src/web/oracle/webcenter/collab/calendar/views/jsf/fragment/calendar_timebar_task-flow-definition.xml</td>
<td></td>
</tr>
<tr>
<td>Calendar Personal Timebar</td>
<td>event-view.jar</td>
<td>event-relationship</td>
<td>wpfas/modules/collaboration/event-service/view/src/web/oracle/webcenter/collab/calendar/views/jsf/relation/event_relationship_task-flow-definition.xml</td>
<td></td>
</tr>
<tr>
<td>Event Relationship</td>
<td>event-view.jar</td>
<td></td>
<td>adfp/modules/extapp/extapp-rt-view/src/web/oracle/adfinternal/extapp/view/fragments/extapp-change-password-taskflow.xml</td>
<td></td>
</tr>
<tr>
<td>Credential Provisioning Page</td>
<td>oracle.extapp.view.jar</td>
<td>extapp-credential-provisioning-taskflow</td>
<td>adfp/modules/extapp/extapp-rt-view/src/web/oracle/adfinternal/extapp/view/fragments/extapp-credential-provisioning-taskflow.xml</td>
<td></td>
</tr>
<tr>
<td>Instant Messaging and Presence Service</td>
<td>rtc-view.jar</td>
<td>rtc-buddy-list-task-flow-definition</td>
<td>wpfas/modules/collaboration/rtc-service/view/src/web/oracle/webcenter/collab/rtc/view/resources/rtc-buddy-list-task-flow-definition.xml</td>
<td></td>
</tr>
<tr>
<td>Service</td>
<td>View Type</td>
<td>View File</td>
<td>Task Flow XML</td>
<td></td>
</tr>
<tr>
<td>-----------------</td>
<td>---------------</td>
<td>----------------------</td>
<td>--------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Lists Service</td>
<td>List Customization View</td>
<td>list-service-view.jar</td>
<td>list-cust-task-flow</td>
<td>wpfas/modules/list-service/view/src/web/oracle/webcenter/list/view/jsf/region/list-cust-task-flow.xml</td>
</tr>
<tr>
<td></td>
<td>Edit List View</td>
<td>list-service-view.jar</td>
<td>list-edit-task-flow</td>
<td>wpfas/modules/list-service/view/src/web/oracle/webcenter/list/view/jsf/region/list-edit-task-flow.xml</td>
</tr>
<tr>
<td></td>
<td>List Instance View</td>
<td>list-service-view.jar</td>
<td>list-instance-view-task-flow</td>
<td>wpfas/modules/list-service/view/src/web/oracle/webcenter/list/view/jsf/region/list-instance-view-task-flow.xml</td>
</tr>
<tr>
<td></td>
<td>List Main View</td>
<td>list-service-view.jar</td>
<td>main-view-task-flow</td>
<td>wpfas/modules/list-service/view/src/web/oracle/webcenter/list/view/jsf/region/main-view-task-flow.xml</td>
</tr>
<tr>
<td>Mail Service</td>
<td>Mail DL Configuration View</td>
<td>mail-view.jar</td>
<td>dl-config-view</td>
<td>wpfas/modules/collaboration/mail-service/view-new/src/web/oracle/webcenter/collab/mail/view/jsf/region/dl-config-definition.xml</td>
</tr>
<tr>
<td></td>
<td>Mail Compose View</td>
<td>mail-view.jar</td>
<td>mail-compose-view</td>
<td>wpfas/modules/collaboration/mail-service/view-new/src/web/oracle/webcenter/collab/mail/view/jsf/region/compose-task-flow.xml</td>
</tr>
<tr>
<td></td>
<td>Mail Content View</td>
<td>mail-view.jar</td>
<td>mail-content-view</td>
<td>wpfas/modules/collaboration/mail-service/view-new/src/web/oracle/webcenter/collab/mail/view/jsf/region/content-view-definition.xml</td>
</tr>
<tr>
<td></td>
<td>Mail Mini View</td>
<td>mail-view.jar</td>
<td>mail-mini-view</td>
<td>wpfas/modules/collaboration/mail-service/view-new/src/web/oracle/webcenter/collab/mail/view/jsf/region/mini-view-definition.xml</td>
</tr>
<tr>
<td></td>
<td>Mail Preference View</td>
<td>mail-view.jar</td>
<td>preference-view</td>
<td>wpfas/modules/collaboration/mail-service/view-new/src/web/oracle/webcenter/collab/mail/view/jsf/region/preference-task-flow.xml</td>
</tr>
<tr>
<td></td>
<td>Notes</td>
<td>notev.jar</td>
<td>notes</td>
<td>wpfas/modules/note-service/view/src/web/oracle/webcenter/note/view/jsf/region/notes.xml</td>
</tr>
<tr>
<td></td>
<td>Create Page</td>
<td>page-service-view.jar</td>
<td>page-create-page</td>
<td>wpfas/modules/page-service/view/src/web/oracle/webcenter/page/view/jsf/fragments/page-create-page.xml</td>
</tr>
</tbody>
</table>
|                 | Document Property | page-service-view.jar | page-doc-prop-panel                  | wpfas/modules/page-
<table>
<thead>
<tr>
<th>Component</th>
<th>Jar File</th>
<th>Definition File</th>
<th>Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>Panel</td>
<td>view.jar</td>
<td>definition</td>
<td>service/view/src/web/oracle/webcenter/page/view/jsf/fragments/page-doc-prop-panel-definition.xml</td>
</tr>
<tr>
<td>Page Picker Panel</td>
<td>page-service-view.jar</td>
<td>page-picker-panel-definition</td>
<td>wpfas/modules/page-service/view/src/web/oracle/webcenter/page/view/jsf/fragments/page-picker-panel-definition.xml</td>
</tr>
<tr>
<td>Property Panel</td>
<td>page-service-view.jar</td>
<td>page-prop-panel-param-definition</td>
<td>wpfas/modules/page-service/view/src/web/oracle/webcenter/page/view/jsf/fragments/page-prop-panel-param-definition.xml</td>
</tr>
<tr>
<td>People Picker</td>
<td>peoplepicker.jar</td>
<td>grouppicker</td>
<td>wpfas/modules/security/peoplepicker/src/web/oracle/webcenter/security/peoplepicker/jsf/taskflows/peoplepicker.xml</td>
</tr>
<tr>
<td>Group Picker</td>
<td>peoplepicker.jar</td>
<td>peoplepicker</td>
<td>wpfas/modules/security/peoplepicker/src/web/oracle/webcenter/security/peoplepicker/jsf/taskflows/peoplepicker.xml</td>
</tr>
<tr>
<td>Recent Activities</td>
<td>recentactivity-service-view.jar</td>
<td>recent-activities</td>
<td>wpfas/modules/recentactivity-service/view/src/web/oracle/webcenter/relationship/taskflows/recent-activities.xml</td>
</tr>
<tr>
<td>Search</td>
<td>search-service-view.jar</td>
<td>all-saved-search</td>
<td>wpfas/modules/search-service/view/src/web/oracle/webcenter/search/controller/taskflows/allSavedSearches.xml</td>
</tr>
<tr>
<td>Save Search</td>
<td>search-service-view.jar</td>
<td>all-saved-search</td>
<td>wpfas/modules/search-service/view/src/web/oracle/webcenter/search/controller/taskflows/customize.xml</td>
</tr>
<tr>
<td>Search Customization</td>
<td>search-service-view.jar</td>
<td>search-customize</td>
<td>wpfas/modules/search-service/view/src/web/oracle/webcenter/search/controller/taskflows/preferences.xml</td>
</tr>
<tr>
<td>Search Mini View</td>
<td>search-service-view.jar</td>
<td>search-sidebar</td>
<td>wpfas/modules/search-service/view/src/web/oracle/webcenter/search/controller/taskflows/recentSavedSearches.xml</td>
</tr>
<tr>
<td>Feature</td>
<td>Module</td>
<td>Directory</td>
<td>File Name</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>-------------------------------</td>
<td>-----------------------------------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>Search Simple View</td>
<td>search-service-view.jar</td>
<td>search-simple-view</td>
<td>wpfas/modules/search-service/view/src/oracle/webcenter/search/controller/taskflows/simpleSearchResults.xml</td>
</tr>
<tr>
<td>Search Tool Bar</td>
<td>search-service-view.jar</td>
<td>search-toolbar</td>
<td>wpfas/modules/search-service/view/src/oracle/webcenter/search/controller/taskflows/localToolbarSearch.xml</td>
</tr>
<tr>
<td>Search Main View</td>
<td>search-service-view.jar</td>
<td>search-view</td>
<td>wpfas/modules/search-service/view/src/oracle/webcenter/search/controller/taskflows/searchResults.xml</td>
</tr>
<tr>
<td>Tags Service</td>
<td>tagging-service-view.jar</td>
<td>related-resources</td>
<td>wpfas/modules/tagging-service/view/src/oracle/webcenter/tagging/controller/taskflows/related-resources.xml</td>
</tr>
<tr>
<td>Tag Center</td>
<td>tagging-service-view.jar</td>
<td>tag-center</td>
<td>wpfas/modules/tagging-service/view/src/oracle/webcenter/tagging/controller/taskflows/tag-center-task-flow.xml</td>
</tr>
<tr>
<td>Tag Center Related Tags</td>
<td>tagging-service-view.jar</td>
<td>tag-center-related-tags</td>
<td>wpfas/modules/tagging-service/view/src/oracle/webcenter/tagging/controller/taskflows/tag-center-related-tags.xml</td>
</tr>
<tr>
<td>Tag Center Related Users</td>
<td>tagging-service-view.jar</td>
<td>tag-center-related-users</td>
<td>wpfas/modules/tagging-service/view/src/oracle/webcenter/tagging/controller/taskflows/tag-center-related-users.xml</td>
</tr>
<tr>
<td>Tagging Mini View</td>
<td>tagging-service-view.jar</td>
<td>tagging-miniview</td>
<td>wpfas/modules/tagging-service/view/src/oracle/webcenter/tagging/controller/taskflows/tagging-miniview.xml</td>
</tr>
<tr>
<td>Tagging Personal View</td>
<td>tagging-service-view.jar</td>
<td>tagging-personal-view</td>
<td>wpfas/modules/tagging-service/view/src/oracle/webcenter/tagging/controller/taskflows/tagging-personal-view.xml</td>
</tr>
<tr>
<td>Tagging Related Links</td>
<td>tagging-service-view.jar</td>
<td>tagging-related-links</td>
<td>wpfas/modules/tagging-service/view/src/oracle/webcenter/tagging/controller/taskflows/tagging-related-links.xml</td>
</tr>
<tr>
<td>Worklist Service</td>
<td>worklist-service-ui.jar</td>
<td>worklist</td>
<td>wpfas/modules/wpworklist-service/worklist-service-ui-</td>
</tr>
<tr>
<td>WebCenter Spaces Task Flows</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Application Navigator</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application Link Manager</td>
<td>webcenter-app-view.jar</td>
<td>AppLinksManageUITaskFlow</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>AppNav-task-flow</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/applinks/AppNavigatorRegion.xml</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>WCLinksManageUIRegion</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/applinks/WCLinksManageUIRegion.xml</td>
<td></td>
</tr>
<tr>
<td><strong>Group Spaces</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Space Administration</td>
<td>webcenter-app-view.jar</td>
<td>CommunityAdministrationTaskFlow</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/admin/CommunityAdministrationTaskFlow.xml</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CommunityBrowserRegion</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/browser/CommunityBrowserRegion.xml</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>CommunitySwitcherRegion</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/switcher/CommunitySwitcherRegion.xml</td>
<td></td>
</tr>
<tr>
<td><strong>Group Spaces</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Group Space Subscription</td>
<td>webcenter-app-view.jar</td>
<td>GroupSpaceSubscriptionTaskflow</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/security/GroupSpaceSubscriptionTaskflow.xml</td>
<td></td>
</tr>
<tr>
<td><strong>Group Spaces</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Template Management</td>
<td>webcenter-app-view.jar</td>
<td>SpaceTemplateManageRegion</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/manage/SpaceTemplateManageRegion.xml</td>
<td></td>
</tr>
<tr>
<td><strong>Page Management</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Action Popup</td>
<td>webcenter-app-view.jar</td>
<td>PageActionsPopupRegion</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/page/PageActionsPopupRegion.xml</td>
<td></td>
</tr>
<tr>
<td><strong>Page Management</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Actions Menu, Tags, and Links on Local Toolbar</td>
<td>webcenter-app-view.jar</td>
<td>PageContextLinksRegion</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/page/PageContextLinksRegion.xml</td>
<td></td>
</tr>
<tr>
<td><strong>Page Management</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Page Create</td>
<td>webcenter-app-view.jar</td>
<td>PageCreationRegion</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>workplace/src/apps/webcenter-app/webcenter-core-webapp/src/java/oracle/webcenter/webcenterapp/view/taskflows/page/PageCreationRegion.xml</td>
<td></td>
</tr>
<tr>
<td>Page Management</td>
<td>Table of Pages</td>
<td>webcenter-app-view.jar</td>
<td>TableOfPagesRegion</td>
</tr>
<tr>
<td>--------------------------</td>
<td>----------------</td>
<td>------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td>WebCenter Administration</td>
<td>Group Spaces Tab</td>
<td>webcenter-app-view.jar</td>
<td>WebCenterAdministrationTaskFlow-Communities</td>
</tr>
<tr>
<td>WebCenter Administration</td>
<td>Welcome Page</td>
<td>webcenter-app-view.jar</td>
<td>WebCenterAdministratorTaskFlow-Primary</td>
</tr>
<tr>
<td>ToolBar</td>
<td>Description</td>
<td>Module</td>
<td>File Name</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------</td>
<td>---------------------------------------------</td>
<td>---------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Global Toolbar</td>
<td>Global Toolbar in Page Maximized View</td>
<td>webcenter-app-view.jar</td>
<td>GlobalToolbarRegion</td>
</tr>
<tr>
<td>Global Toolbar</td>
<td>Global Toolbar in Spaces Maximized View</td>
<td>webcenter-app-view.jar</td>
<td>GlobalToolbarRegion</td>
</tr>
<tr>
<td>Language Selector</td>
<td>Language Selector</td>
<td>webcenter-app-view.jar</td>
<td>LanguageSelectorRegion</td>
</tr>
<tr>
<td>Local Toolbar</td>
<td>Local Toolbar in Normal View</td>
<td>webcenter-app-view.jar</td>
<td>LocalToolbarRegion</td>
</tr>
<tr>
<td>Local Toolbar</td>
<td>Local Toolbar in Spaces Maximized View</td>
<td>webcenter-app-view.jar</td>
<td>LocalToolbarRegion</td>
</tr>
<tr>
<td>Secondary Tab Bar</td>
<td>Secondary Tab Bar</td>
<td>webcenter-app-view.jar</td>
<td>SecondaryTabBarRegion</td>
</tr>
<tr>
<td>Login</td>
<td>Login Page</td>
<td>webcenter-app-view.jar</td>
<td>LoginTaskflow</td>
</tr>
<tr>
<td>About</td>
<td>About</td>
<td>webcenter-app-view.jar</td>
<td>AboutTaskFlow</td>
</tr>
<tr>
<td>Help</td>
<td>Personalize Help</td>
<td>webcenter-app-view.jar</td>
<td>PersonalizeWebCenterHelpTaskFlow.xml</td>
</tr>
<tr>
<td>Favorites</td>
<td>Favorites</td>
<td>webcenter-app-view.jar</td>
<td>FavoritesTaskFlow</td>
</tr>
<tr>
<td>Preferences</td>
<td>Preferences Dialog</td>
<td>webcenter-app-view.jar</td>
<td>preference-main-dialog</td>
</tr>
<tr>
<td>Footer</td>
<td>Footer Normal View</td>
<td>webcenter-app-view.jar</td>
<td>ApplicationFooterRegion</td>
</tr>
<tr>
<td>Footer</td>
<td>Footer in Spaces Maximized View</td>
<td>webcenter-app-view.jar</td>
<td>ApplicationFooterRegion</td>
</tr>
</tbody>
</table>
Conclusion

Oracle WebCenter enables you to customize the look and feel of the default Oracle ADF task flows provided by the WebCenter Web 2.0 Services and WebCenter Spaces. You can customize these task flows at design time in Oracle JDeveloper and apply them to applications that are either in development or already deployed.

You can learn more about Oracle ADF task flow customization in Oracle Fusion Middleware Developer’s Guide for Application Development Framework, and more about Oracle WebCenter and WebCenter 2.0 Services in the Oracle Fusion Middleware Developer’s Guide for Oracle WebCenter.